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1. Introduction 

 

 

Solar maps of cities are every day more demanded by citizens

 

The progressive reduction of costs of photovoltaic technologies has made these technologies a viable 

alternative as complementary source of energy.

infrastructures it is necessary to have data. Therefore several cities around the world have launched their 

solar maps. 

 

Huellasolar is working some years ago to allow people to access this sort of data. When we launched our 

OpenPlatform we became the first web offering an on line environment where users around the world can 

build their own solar maps. 

 

The solar maps built using huellasolar allow 

area in the city, not only on roofs but also on streets or facades. They have a lot of features useful for 

companies, professionals in urban development

 

 

2. Objectives 

 

 

This manual explains, step by step and with a lot of screen 

a city starting with a lidar file. 

 

The map can be open from the viewer of radiation and sun exposure huellasolar

available. Electrical productions and savings, Co2 savings, radiation in

according to their sun exposure levels, chart of shadows, solar maps of facades etc.

 

Any data and software used in this guide has open 

The map will have also an open license Creative Commons non

 

This manual uses lidar files available at the National Center for Geographical Information (CNIG. Spain). 

Nevertheless you can follow this guide using lidar from any other source.

 

 

 

Using the Open Platform of huellasolar

shp, asc etc). This guide focuses in the procedure using lidar files but is possible to build a solar map from 

any other format if you have the necessary information and it is possible to format your data to t

used by huellasolar. 

If you have questions about how to generate a solar map starting with other sort of data contact the 

huellasolar team. We will support you.

 

  

cities are every day more demanded by citizens, professionals, institutions etc. 

The progressive reduction of costs of photovoltaic technologies has made these technologies a viable 

alternative as complementary source of energy. Nevertheless, to study the implantation of

to have data. Therefore several cities around the world have launched their 

Huellasolar is working some years ago to allow people to access this sort of data. When we launched our 

tform we became the first web offering an on line environment where users around the world can 

The solar maps built using huellasolar allow estimating electrical productions and economics savings for any 

nly on roofs but also on streets or facades. They have a lot of features useful for 

in urban development, institutions working on energy and efficiency

, step by step and with a lot of screen shots, how to make a solar map of a fragment of 

The map can be open from the viewer of radiation and sun exposure huellasolar

available. Electrical productions and savings, Co2 savings, radiation in points and areas, detections of areas 

according to their sun exposure levels, chart of shadows, solar maps of facades etc. 

Any data and software used in this guide has open licenses or are free. 

The map will have also an open license Creative Commons non commercial. 

This manual uses lidar files available at the National Center for Geographical Information (CNIG. Spain). 

Nevertheless you can follow this guide using lidar from any other source. 

Using the Open Platform of huellasolar you can build solar maps starting with other source of data (dwg, 

shp, asc etc). This guide focuses in the procedure using lidar files but is possible to build a solar map from 

any other format if you have the necessary information and it is possible to format your data to t

If you have questions about how to generate a solar map starting with other sort of data contact the 

support you. 
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The map can be open from the viewer of radiation and sun exposure huellasolar with all the features 

points and areas, detections of areas 

 

This manual uses lidar files available at the National Center for Geographical Information (CNIG. Spain). 

maps starting with other source of data (dwg, 

shp, asc etc). This guide focuses in the procedure using lidar files but is possible to build a solar map from 

any other format if you have the necessary information and it is possible to format your data to the format 

If you have questions about how to generate a solar map starting with other sort of data contact the 
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START POINT END POINT 

Screen shot of the lidar file that we are going to use 

in this document. 

(Screenshot from the viewer fugroview) 

The solar map built at the end of this manual. 

The solar map will be displayed with the huellasolar 

viewer. 

 

We hope this document could help you. If you have any question o any issue trying to build your solar maps, 

please, contact us at info@huellasolar.com, we will support you. 

 

 

3. Starting point and software 

 

 

First of all we need the .las or .laz files from lidar. Below we explain how to download these files for the 

CNIG. 

 

We are going to use the following software: 

 

- Qgis Desktop. (Screen shots from v.1.8.0) 

Qgis is a Geographical Information System (GIS) Open Source and GNU. 

Link: http://www.qgis.org/es/site/ 

  

It should have the plugin with the LasTools in order to deal with lidar data. 

  

Link to download LasTools.zip: http://www.cs.unc.edu/~isenburg/lastools/download/ 

 Link to a tutorial to set up LasTools on Qgis: 

 (Spanish)  

http://mappinggis.com/2015/04/como-configurar-lastools-en-qgis/ 

 (English  and several versions of Qgis)  

http://rapidlasso.com/2013/09/29/how-to-install-lastools-toolbox-in-qgis/ 

 

- Gvsig. (Screen shots from v.1.11.0) 

Gvsig is a Geographical Information System (GIS) Open Source and GNU. 

 

Link: http://www.gvsig.org  

 

We are using Qgis and Gvsig to forma tour lidar file and save it as a raster to be recognized by 

huellasolar. 
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- Gimp. (Screen shots from v.2.8.14) 

Gimp is free software from manage image files. 

 

Link: http://www.gimp.org/ 

 

We are using Gimp to Split the raster in the squares that  form our map. 

 

- Huellasolar Open Platform.  

Huellasolar is a web Project that offers tools and the environment to build solar maps. 

It has free accounts to build maps up to 1.44Km
2
. 

We are using the open platform of huellasolar to compile the map and publish it. 

 

Link: http://www.huellasolar.com 

 

 

4. Downloading lidar data from the CNIG 

 

 

In this guide we are using lidar from de National Center for Geographical Information in Spain. If you have 

lidar files from any other sources you can go to the next step. 

 

Here we are going to explain how to locate and download this data from the web of de CNIG. 

 

Visit the CNIG here: 

http://centrodedescargas.cnig.es/CentroDescargas/catalogo.do 

 

 

There you can find ‘LIDAR’ from a list of several products as the following image shows 

 

 
 

Follow the link ‘Descargar’ 

There we can make a search by city. However we are going to use the search with viewer. 
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Once you are at the viewer follow these steps: 

 

 
 

1. Select the city 

2. Select the product  ‘LIDAR (laz 2x2km) 

3. Search mode ‘Polígono dibujado en la pantalla’ 

4. Click on the button to draw polygons 

5. Draw a polygon over the area of your interest 

6. Click on  ‘Buscar’ 

 

The list of files for the area will be displayed 

 

 
 

Now you only have to follow the download process. 

So we now have our lidar file to start working. 

 

 

5. Formatting data with Qgis 

 

 

First we are going to format our .laz file (or .las) to a raster. 

We go to the Sextante panel in Qgis. If it is not visible, open it from the Menu: 

View->Panels->Sextante Toolbox 

If you do not have this option available you must install the plugin. 

1 
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At the Sextante panel select ‘Tools for LIDAR data’ and double 

following image. 

 

You must have the LasTools configured in your Qgis. Look at the links 

to install these tools. 

 

 

 

 

 

select ‘Tools for LIDAR data’ and double click on ‘lasgrid’ as you can see in the 

You must have the LasTools configured in your Qgis. Look at the links of the second section of this manual 
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on ‘lasgrid’ as you can see in the 

of the second section of this manual 



 

Follow these steps in the pop up window:

 

1. Select the path to our laz file

2. Step size = 2 

 

The user can test with other values depending of 

With our file this value outputs a good result without excessive pix

3. Attribute  ‘elevation’ 

4. The name for our output file

5. Check in to output the file in the view.

 

Ok, and we will have something like this

 

 

5 

Follow these steps in the pop up window: 

to our laz file 

The user can test with other values depending of your  lidar configuration. 

With our file this value outputs a good result without excessive pixelation. 

The name for our output file. Select .tif format. 

Check in to output the file in the view. 

and we will have something like this: 

1 
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Now we are going to fill the points without data of the raster. 

 

Menu  Raster->Analyze->Fill empty data 

 

 
 

We will see the following window: 

 

 
 

 

1. Select the input layer. It Is just what we have already created. 

2. The name for the output file. The output format must be geoTIFF(*.tiff) 

 

IMPORTANT. Support to tif files is added from versión 2.0 of the desktop tool. 

 

Nevertheless you can find in the appendix ‘Trasforming Geotif into PNG file supported by huellasolar’ the 

method used with the old version 1.0 which only supports png files with a specific format.  

 

To know more about differences between use tif or png files while are working with huellasolar, go to the 

appendix ‘Differences between results with PNG ot TIF files’  

 

  

1 

2 



 

 

6. Splitting the map in tiles 

 

 

By the moment we have just transform

Now we must split the tif file into the 

 

 

If you are working in a shared map of huellasolar

In these cases you can skip this point and go to the 

 

Note: Images of this point are taken from version 2.12.0

 

First let’s open the tif file saved in the point 5 of this manual.

In order to save the different tiles of our map we are going to use the tool ‘Clipper’ of the Qgis software.

Choose the menu Raster->Extract->Clipper

 

  

transform our lidar file to a geotiff file. 

Now we must split the tif file into the different tiles of our map. 

shared map of huellasolar, a number of Kml files have been sent to your mail.

In these cases you can skip this point and go to the annex III ‘Trimming a Geotif with a kml file’

point are taken from version 2.12.0-Lyon of Qgis 

First let’s open the tif file saved in the point 5 of this manual. 

In order to save the different tiles of our map we are going to use the tool ‘Clipper’ of the Qgis software.

>Clipper 
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have been sent to your mail. 

annex III ‘Trimming a Geotif with a kml file’ 

In order to save the different tiles of our map we are going to use the tool ‘Clipper’ of the Qgis software. 

 



 

 

The following window appears: 

 

 

1. Select folder and name of file to save. In our case it will be the first tile of the map called 0101.tif. 

The output format must be tif.

 

 

The tiles of the map must be saved with

correspond to the column and the last two digits are for the row. The tile 0101 is placed in the first column 

first row. It starts from the lower left corner. Null values such as 0000 are not admitted

system. 

 

2. Clipping Mode Extent. 

 

 

This mode makes the selection directly drawing on the map. If your map has many tiles you could consider 

using the mode ‘Mask Layer’. You should have a set of vector layers defining the different 

and use those layers to cut out the map in tiles.

 

3. Draw a rectangle approximately on the area of the first tile

4. Adjust the coordinates. The area must size exactly the dimension we want for our tiles. In our case 

we want tiles of 400x400m 

Sector 0101 -> X1: 505000 X2: 505400 / Y1:

We save these values to process with the following tiles. 

Sector 0102-> X1: 505000 X2: 505400 / Y1: 4789400 Y2: 4789000

Sector 0201-> X1: 505400 X2: 505800 / Y1: 4789000 Y2: 4788600

Sector 0202-> X1: 505400 X2: 505800 / Y1: 4789400 Y2: 4789000

5. Finally we accept to save the file

 

Now is we see the dimension of the tif we have just saved we notice that it is 200x200pixels. However w

want our tiles of 400x400m (Take into account that huellasolar’s 

 

It is because we selected the value ‘step size’ = 2 when we processed the lidar with the ‘las2grid’ tool (See 

point 5 of this manual). We made this to reduce the pixilation of the data.

2 

4 

5 

Select folder and name of file to save. In our case it will be the first tile of the map called 0101.tif. 

The output format must be tif. 

The tiles of the map must be saved with names with four numbers each one. The first two digits 

correspond to the column and the last two digits are for the row. The tile 0101 is placed in the first column 

first row. It starts from the lower left corner. Null values such as 0000 are not admitted

This mode makes the selection directly drawing on the map. If your map has many tiles you could consider 

using the mode ‘Mask Layer’. You should have a set of vector layers defining the different 

and use those layers to cut out the map in tiles. 

Draw a rectangle approximately on the area of the first tile 

Adjust the coordinates. The area must size exactly the dimension we want for our tiles. In our case 

 so the coordinates have been adjusted as follows:

> X1: 505000 X2: 505400 / Y1: 4789000 Y2: 4788600 

to process with the following tiles. For example: 

> X1: 505000 X2: 505400 / Y1: 4789400 Y2: 4789000 

> X1: 505400 X2: 505800 / Y1: 4789000 Y2: 4788600 

> X1: 505400 X2: 505800 / Y1: 4789400 Y2: 4789000 

Finally we accept to save the file 

Now is we see the dimension of the tif we have just saved we notice that it is 200x200pixels. However w

want our tiles of 400x400m (Take into account that huellasolar’s tools works with a coefficient m/pixel = 1)

we selected the value ‘step size’ = 2 when we processed the lidar with the ‘las2grid’ tool (See 

this to reduce the pixilation of the data. 

1 
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Select folder and name of file to save. In our case it will be the first tile of the map called 0101.tif. 

names with four numbers each one. The first two digits 

correspond to the column and the last two digits are for the row. The tile 0101 is placed in the first column 

first row. It starts from the lower left corner. Null values such as 0000 are not admitted for the huellasolar 

This mode makes the selection directly drawing on the map. If your map has many tiles you could consider 

using the mode ‘Mask Layer’. You should have a set of vector layers defining the different tiles of your map 

Adjust the coordinates. The area must size exactly the dimension we want for our tiles. In our case 

so the coordinates have been adjusted as follows: 

Now is we see the dimension of the tif we have just saved we notice that it is 200x200pixels. However we 

with a coefficient m/pixel = 1) 

we selected the value ‘step size’ = 2 when we processed the lidar with the ‘las2grid’ tool (See 
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Now we are going to save the tif with the correct pixel/meter value. 

It is pretty easy, we have just to ‘save as’ the file as follows. 

We select the layer in the list of layers of Qgis and place the mouse pointer on it to open the contextual 

menu with right click. The we select ‘Save as’  

 

 
 

The following menu will be displayed 

 

 
 

1. Select the same folder and file to overwrite it 

2. In resolution select 1. You can see that the grey values of ‘Layer size’ change to 400 which is the 

real size of our tiles. 

3. Accept to overwrite the file. 

 

Now we can see that the tif size has changed to 400x400pixels which and therefore now the file has a 

relation 1pixel = 1meter. 

1 

2 
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We can repeat the same process for the re

processed with the desktop tool of huellasolar.

 

 

7. Building data packages with huellasolar

 

 

Now we are going to build necessary data package to configure our solar map.

To this purpose we are going to use the ‘huellasolar data builder desktop tool’.

We can download this free tool from the web 

available for windows systems. 

 

 

Download, install and open the tool.

 

 

1. Select the type of file. In our case tif

 

2. Select the directory where the files of the tiles of our map are stored

just saved in the previous step

 

 

Once you select the directory the files

directory. Check if there are other files named also with four numbers, finally check that all the files of the 

tiles have the same dimension in pixels.

 

3. Type the coordinates of your map. Must be the coordinates for the lower left corner of the map as 

in the image below. 

We can repeat the same process for the rest of tiles of the map to have all the files of our map ready to be 

processed with the desktop tool of huellasolar. 

Building data packages with huellasolar 

to build necessary data package to configure our solar map. 

are going to use the ‘huellasolar data builder desktop tool’. 

We can download this free tool from the web www.huellasolar , section ‘Documentation’. The tool is only 

and open the tool. 

Select the type of file. In our case tif 

Select the directory where the files of the tiles of our map are stored (These are the files we have 

step). 

directory the files will be listed. If this is not the case check the type of file. C

directory. Check if there are other files named also with four numbers, finally check that all the files of the 

tiles have the same dimension in pixels. 

e coordinates of your map. Must be the coordinates for the lower left corner of the map as 

2 

3 
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st of tiles of the map to have all the files of our map ready to be 

, section ‘Documentation’. The tool is only 

 

 

These are the files we have 

check the type of file. Check the 

directory. Check if there are other files named also with four numbers, finally check that all the files of the 

e coordinates of your map. Must be the coordinates for the lower left corner of the map as 

5 
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Save the values of long and lat of your map. You will need them later.

Take into account that West and South values must be negative.

 

 

You can take the coordinates from Google Earth. They must be WGS 84 coordinates. If you take them from 

Google Earth they already are in WGS 84. Otherwise you should make the coordinates transformation.

 

4. Select of the files from the list

5. Click on ‘Process’ 

 

The app will start the calculations.  

 

Take into account that each tile can take several minutes. The whole map can take long time to be 

processed. 

 

 

 

1. You can check the progress from the progress bar

2. You can see a session id in the lower 

id inside the work directory.

 

Once the work is done a pop up window will be displayed with the path to the results.

They are stored in a directory with the following name:

 “[The selected work directory]/Session [

 

In this path you will find a group of files named as follow:

“hso_package_[the number of tile]_[the id of the package of data].hsp”

 
Save the values of long and lat of your map. You will need them later. 

Take into account that West and South values must be negative. 

can take the coordinates from Google Earth. They must be WGS 84 coordinates. If you take them from 

Google Earth they already are in WGS 84. Otherwise you should make the coordinates transformation.

Select of the files from the list 

 

Take into account that each tile can take several minutes. The whole map can take long time to be 

You can check the progress from the progress bar 

session id in the lower right corner. The results will be stored in a directory with this 

id inside the work directory. 

Once the work is done a pop up window will be displayed with the path to the results.

in a directory with the following name: 

Session [The id of the work session]” 

a group of files named as follow: 

“hso_package_[the number of tile]_[the id of the package of data].hsp” 
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can take the coordinates from Google Earth. They must be WGS 84 coordinates. If you take them from 

Google Earth they already are in WGS 84. Otherwise you should make the coordinates transformation. 

Take into account that each tile can take several minutes. The whole map can take long time to be 

 

right corner. The results will be stored in a directory with this 

Once the work is done a pop up window will be displayed with the path to the results. 

1 

2 



 www.huellasolar.com 

 

Example: hso_package_0101_5.hsp 

 

Additionally you will find png files for each tile formatted as it is explained in the appendix I of this manual. 

If you are working with png files, they will be just a copy of them. 

If you are working with tif files, these png files are the ones which you should upload to your edition panel 

in the web huellasolar. 

 

Finally we are going to set up our map from the huellasolar web. 

 

 

8. Setting up our map 

 

 

We are going to set up out map from the edition panel of huellasolar. 

To enter the edition panel you must be registered. It is free and easy, only a user name a email is needed. 

 

Once registered go to ‘My projects’ link from the OpenPlatform menu at the top right corner in the 

page.(You must be logged in to see this menu) 

 

 

 
 

This will load the dashboard panel where you can create and manage all your projects. Go to the section 

‘Create new project’: 
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1. Type the title for your map 

2. A more detailed description 

3. The coordinates. They must be the same coordinates you used to generate the package data with 

the desktop tool of huellasolar. Once the project is created you cannot change the coordinates 

4. The country of your map 

5. The license you want to apply to your data. In our case we are using lidar data from the CNIG which 

allow us to use non commercial licenses. Our map will be Creative Commons By 

6. The author of the map 

7. And click on ‘Create’ 

 

Now we have created our Project in huellasolar. The next step is to set up it. 

We can start editing our map clicking on the blue message that is displayed the first time you create a 

project.  

 

 
 

Or you can go to the edition panel of the map form the list of projects in the top of the page:  
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Use any of those two links to enter your edition panel. 

The edition panel has five tabs: Project, Map, Radiation, Production and Publish. 

 

In this guide we leave the default values except the turbidity factor Linke. 

If you want to know more about the edition panel, look up the OpenPlatform manual or the video tutorials 

available in the ‘Documentation’ section. 

Anyway you can edit the map also after its publication. 

 

First of all go to the ‘Map’ tab. Here we are going to upload the packages of data. 

 

There you can see three gray regions to drag and drop the files saved in previous steps.  

 

We will start uploading the raster files of elevations. These are the png files corresponding to each tile of 

our map. They are the png files generated with the ‘huellasolar databuilder’ in the previous point. You can 

find them inside the folder of results. 

In our case are four png files corresponding to each tile of our map: 

 

 

1. Open the explorer and locate the files. Select them and drag and drop inside the first gray region 

2. Click on the upload button 

2 
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Now we are going to upload the packages of data generated with the desktop data builder in the section 

eight of this guide. These packages are a group of sixteen files for each tile of the map with the 

extension .hsp. 

 

We proceed in the same way but drag and drop in the second gray region 

 

You can only upload a tile each time. Select the sixteen files corresponding to the first tile, drag and drop 

and click the upload button. Once uploaded, click on ‘Clear List’ and repeat with the rest of tiles. 

 

 

1. Select the sixteen files corresponding to the tile. Drag and drop in the second gray region 

2. Click the button upload 

3. Once uploaded, clear the list and repeat the process for the rest of tiles. 

We can check that everything is ok from the table at the top of the page. 

 

2 

1 

3 

1 2 3 



 

1. The list of tiles of our map 

2. The png files of elevations for each 

3. The hsp files for each tile have been correctly uploaded

 

You can see a column titled ‘Mask raster’. This is an optional data. If you want to know more about the use 

of mask raster in your solar map look at the manual of 

 

At this point you can already publish your ma

factor Linke. 

We strongly recommend setting up this coefficient

 

The turbidity factor values can be edited from the ‘Radiation’ tab:

 

 

In the web you can find a list of Linke values for different locations around the world. We are going to get 

the values from http://re.jrc.ec.europa.eu/pvgis/apps4/pvest.php

Visit the link and follow these steps.

 

 

1. Select the tab ‘Monthly radiation’

2. Check in the option ‘Linke turbidity’

3. Navigate the map to the location of your map an click on the place

4. Click on ‘Calculate’ button 

5. A pop up window will show the values of Linke turbidity

3 

 

The png files of elevations for each tile have been correctly uploaded 

The hsp files for each tile have been correctly uploaded 

You can see a column titled ‘Mask raster’. This is an optional data. If you want to know more about the use 

of mask raster in your solar map look at the manual of the OpenPlatform of huellasolar.

At this point you can already publish your map, but in this manual we are going to set up also the turbidity 

up this coefficient to improve the accuracy of the radiation results.

The turbidity factor values can be edited from the ‘Radiation’ tab: 

In the web you can find a list of Linke values for different locations around the world. We are going to get 

http://re.jrc.ec.europa.eu/pvgis/apps4/pvest.php . (Valid for Europe).

link and follow these steps. 

‘Monthly radiation’ 

‘Linke turbidity’ and set off the rest of outputs 

Navigate the map to the location of your map an click on the place 

 

A pop up window will show the values of Linke turbidity 

1 
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You can see a column titled ‘Mask raster’. This is an optional data. If you want to know more about the use 

the OpenPlatform of huellasolar. 

p, but in this manual we are going to set up also the turbidity 

to improve the accuracy of the radiation results. 

 

In the web you can find a list of Linke values for different locations around the world. We are going to get 

. (Valid for Europe). 
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Now we only have to translate these values to our edition panel. 

 

 
 

1. Type the values of Linke turbidity 

2. Save changes 

 

 

9. Publishing and viewing the map. Brief list of features available. 

 

 

Our map is ready to be published. Go to the tab ‘Publish’ 

 

Once you have reached this point, to publish your map is quite simple. Only click on the button ‘Publish 

now’ 

 

 
 

If everything goes right we will have a screen like this: 

 

 

1 
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Our map is published! 

 

We can click on the blue message to visit it. 

You can enter the map also from the world map of the huellasolar viewer. 

 

 

Here we have our map once opened In the viewer of radiation and sun exposure. Now we can start to 

analyze it with all the features available. 

 

Below we made a brief description of the main features. If you want a more detailed explanation download 

the manual of the viewer from the section ‘Documentation’ of the web. 

 

  



 

 

Estimation for areas. This option make calculations of radiation and electrical production, 

among other outputs, for any area in the map.

 
Radiation in a point. This feature calculates monthly and hourly values of radiation in a point 

Estimation for areas. This option make calculations of radiation and electrical production, 

among other outputs, for any area in the map. 

Radiation in a point. This feature calculates monthly and hourly values of radiation in a point 
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Estimation for areas. This option make calculations of radiation and electrical production, 

 

Radiation in a point. This feature calculates monthly and hourly values of radiation in a point  

 



 

 

Filter of sun exposure. This feature allows to detect regions according to their average values of 

annual sun exposure  

 

Monthly filter of sun exposure

percentages  of sun exposure

 

Filter of sun exposure. This feature allows to detect regions according to their average values of 

exposure. This option detects regions according to their monthly 

percentages  of sun exposure 
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Filter of sun exposure. This feature allows to detect regions according to their average values of 

 

This option detects regions according to their monthly 

 



 

 
Charts of shadows. This options display a chart with the line of horizon for any point in the map

 

Solar map for vertical planes or facades. Using the

maps for facades. These maps can also be analyzed with the most part of the features available in 

the viewer,  so we can also make calculation of radiation, production, shadows etc on vertical 

planes. 

 

  

This options display a chart with the line of horizon for any point in the map

Solar map for vertical planes or facades. Using the huellasolar viewer you can also generate solar 

maps for facades. These maps can also be analyzed with the most part of the features available in 

the viewer,  so we can also make calculation of radiation, production, shadows etc on vertical 

 www.huellasolar.com 

This options display a chart with the line of horizon for any point in the map 

 
huellasolar viewer you can also generate solar 

maps for facades. These maps can also be analyzed with the most part of the features available in 

the viewer,  so we can also make calculation of radiation, production, shadows etc on vertical 

 



 

 

10. Appendix I. Trasforming Geotif into PNG file supported by huellasolar

 

 

IMPORTANT:  

From version 2.0 of the data builder, Geotif files are supported.

Version 1.0 only worked with PNG files formatted in a specific way.

This appendix explains the method to 

useful depending of the source of your data if you prefer to work with png files instead of tif files.

 

Once we have transformed our lidar file into a tif file we are going to format 

huellasolar environment. 

 

To this purpose we are going to apply a color table to the geotif using the software Gvsig.

 

 

It is possible apply color tables using Qgis and save the result as image using the plugin 

paletted or RGB raster’. However, this plugin make slight changes to the rgb values. We recommend to use 

the procedure in this manual using Gvsig to apply color tables.

  

 

Huellasolar Works with png files where rgb values are the elevation. This 

values of the geotiff are transformed to integer values. In fact this approximation usually works fine 

because it regularizes the surface of buildings.

From huellasolar there are various internal criteria to use this forma

support to directly use geotiff in the platform.

 

Now we are going to open the geotiff of the previous step using Gvsig.

Open Gvsig. In the projects manager select ‘Vista’ ‘Nuevo’ and double click
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Appendix I. Trasforming Geotif into PNG file supported by huellasolar 

From version 2.0 of the data builder, Geotif files are supported. 

Version 1.0 only worked with PNG files formatted in a specific way. 

This appendix explains the method to transform tif files to png files supported by huellasolar. It can be 

useful depending of the source of your data if you prefer to work with png files instead of tif files.

Once we have transformed our lidar file into a tif file we are going to format it as png file supported by the 

To this purpose we are going to apply a color table to the geotif using the software Gvsig.

It is possible apply color tables using Qgis and save the result as image using the plugin 

. However, this plugin make slight changes to the rgb values. We recommend to use 

the procedure in this manual using Gvsig to apply color tables. 

Huellasolar Works with png files where rgb values are the elevation. This means a simplification

values of the geotiff are transformed to integer values. In fact this approximation usually works fine 

because it regularizes the surface of buildings. 

From huellasolar there are various internal criteria to use this format but may be in future we will give 

support to directly use geotiff in the platform. 

Now we are going to open the geotiff of the previous step using Gvsig. 

Open Gvsig. In the projects manager select ‘Vista’ ‘Nuevo’ and double click on the name of the vie
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transform tif files to png files supported by huellasolar. It can be 

useful depending of the source of your data if you prefer to work with png files instead of tif files. 

png file supported by the 

To this purpose we are going to apply a color table to the geotif using the software Gvsig. 

It is possible apply color tables using Qgis and save the result as image using the plugin ‘one band raster to 

. However, this plugin make slight changes to the rgb values. We recommend to use 

means a simplification. The float 

values of the geotiff are transformed to integer values. In fact this approximation usually works fine 

t but may be in future we will give 

on the name of the view. 
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Once opened the view we are going to load the geotiff. 

 

1. Click on the button add a new layer. 

2. Select ‘Add’ in the pop up window. 

3. Select type of file Raster. 

4. Locate your raster in the explorer and select Open. 

5. Finally select Accept. 

In the viewer we will have something like this: 
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Now we have to know the range of elevations of the raster to build or color table.

Go to the properties of the raster following the next steps.

 

1. Select the layer clicking on its name in the list on the left.

to open the floating menu. 

2. Select the properties of the raster option.

 

In the pop up window select ‘General’ tab

 

 

There we can see the range of elevations of

So we are going to apply a color table from o to 185.

 

 

Negative values usually come from points without data of the lidar unless we are working on a city under 

the sea level. 

Huellasolar do not admit negatives 

elevations so they start from cero.

 

To build the color table we are going to use the tool available at the web huellasolar.

Go to the www.huellasolar.com, section ‘Documentation’

 

1 

Now we have to know the range of elevations of the raster to build or color table. 

Go to the properties of the raster following the next steps. 

 

layer clicking on its name in the list on the left. Once selected, right button of the mouse 

 

Select the properties of the raster option. 

In the pop up window select ‘General’ tab 

There we can see the range of elevations of the raster. In our case from -310 to 185.

So we are going to apply a color table from o to 185. 

me from points without data of the lidar unless we are working on a city under 

Huellasolar do not admit negatives values of elevations. If your city is under the sea level you must fix the 

elevations so they start from cero. 

To build the color table we are going to use the tool available at the web huellasolar.

, section ‘Documentation’ 
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Once selected, right button of the mouse 

 

310 to 185. 

me from points without data of the lidar unless we are working on a city under 

values of elevations. If your city is under the sea level you must fix the 

To build the color table we are going to use the tool available at the web huellasolar. 



 

 

Go to the link ‘Color Table builder for Gvsig’ and follow the steps below:

1. Type the name for your table

2. Type the higher and lower elevations of the raster. They must be integer numbers.

 

We could make a table with a wide range of altitudes, for example, 0

for several raster inside this values.

3. Click on ‘Generate’. In the gray text field it should be prompted the code of our table.

4. Select the text and copy 

5. Paste the text in any text editor and save the file as .txt

6. Change the extension of the file from .txt to .rmf

 

Now we have our color table file. Now we are going to apply it to our raster in Gvsig.

 

1. Click on the button ‘Select raster 

2. In the menu of the button select  ‘Color Table’

1 

Go to the link ‘Color Table builder for Gvsig’ and follow the steps below: 

Type the name for your table 

Type the higher and lower elevations of the raster. They must be integer numbers.

We could make a table with a wide range of altitudes, for example, 0-1000, this way this file could be used 

for several raster inside this values. 

Click on ‘Generate’. In the gray text field it should be prompted the code of our table.

Paste the text in any text editor and save the file as .txt 

Change the extension of the file from .txt to .rmf. 

Now we have our color table file. Now we are going to apply it to our raster in Gvsig.

 
Click on the button ‘Select raster layer’ 

In the menu of the button select  ‘Color Table’ 

2 
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Type the higher and lower elevations of the raster. They must be integer numbers. 

1000, this way this file could be used 

Click on ‘Generate’. In the gray text field it should be prompted the code of our table. 

Now we have our color table file. Now we are going to apply it to our raster in Gvsig. 

3 

4 
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The following window will be open: 

 

 
 

1. Check in the option ‘Activate color table’ 

2. Check off  ‘Interpolated’ 

3. Check off ‘Limits adjust’ 

4. Click on the button ‘Import library’. In the explorer select the file .rmf we have just created. 

5. Finally click on ‘Accept’ 

 

Now our raster should be something like this: 
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4 
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Depending of the elevations of your file the transitions from blue to black could be sharp instead of soft like 

in the image above. Do not worry it could be correct.

 

We have finished the format of our raster. Now we are going to save it as .png file.

The following steps split the image in the squares that build the map and we will start to generate data of 

the solar map using the huellasolar tools.

 

So let save the raster as png file using Gvsig.

 

 

1. Click on ‘Raster layer’ button

2. Select the option export to raster in the drop down menu

 

3. Click the button on the right.

4. And in the drop down menu ‘Save view to georeferrenced raster’

 

A message will be displayed to start the selection of the region  of the view to be saved.

 

We are going to draw a rectangle over our raster. Our solar map is covering an area inside the raster we are 

working on. Now we are going to select all the raster and later we will clip the image to take only the region 

of our map. 

 

Once we have drawn the rectangle a window will be displayed
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Depending of the elevations of your file the transitions from blue to black could be sharp instead of soft like 

the image above. Do not worry it could be correct. 

We have finished the format of our raster. Now we are going to save it as .png file. 

The following steps split the image in the squares that build the map and we will start to generate data of 

map using the huellasolar tools. 

So let save the raster as png file using Gvsig. 

 

Click on ‘Raster layer’ button 

Select the option export to raster in the drop down menu’ 

 

Click the button on the right. 

menu ‘Save view to georeferrenced raster’ 

to start the selection of the region  of the view to be saved.

We are going to draw a rectangle over our raster. Our solar map is covering an area inside the raster we are 

Now we are going to select all the raster and later we will clip the image to take only the region 

the rectangle a window will be displayed: 
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Depending of the elevations of your file the transitions from blue to black could be sharp instead of soft like 

 

The following steps split the image in the squares that build the map and we will start to generate data of 

to start the selection of the region  of the view to be saved. 

We are going to draw a rectangle over our raster. Our solar map is covering an area inside the raster we are 

Now we are going to select all the raster and later we will clip the image to take only the region 



 

 

1. Method mts/pixel 

2. mts/pixel value = 1 

3. Click on ‘Selection’. In the explorer we give name to the file to be saved and select type of file .PNG

4. Finally click on ‘Apply’ 

 

Now we have saved our raster into a png file that can be recognized by huellasolar.

 

 

10.1. Extracting the tiles of our map

 

Our solar map will cover an area of 1200x1200m and it will have 4 tiles of 600x600m each one.

The png file we have just saved is about 2000x2000m (2000x2000 pixels)

So now we are going to split this file into four files, one for each tile of the map.

To this purpose we are going to use Gimp. 

 

 

You can also split the raster using Gvsig. You can take a look to our video tutorial ‘Formatting data, case 

study’ to see this alternative. Find the link to the video from the section ‘Documentation’ of the huellasolar 

web. 

 

Run Gimp and open the png file we have just saved.

 

We are going to activate the grid so it helps us to draw our tiles.

Select the menu ‘Edit’->’Preferences’

 

 

 

Preferences-> tab ‘Default grid’. And type the values of Spacing Width and Height. We are g

values of 100 pixels for the grid. 

 

‘Selection’. In the explorer we give name to the file to be saved and select type of file .PNG

Now we have saved our raster into a png file that can be recognized by huellasolar. 

the tiles of our map 

will cover an area of 1200x1200m and it will have 4 tiles of 600x600m each one.

The png file we have just saved is about 2000x2000m (2000x2000 pixels) 

So now we are going to split this file into four files, one for each tile of the map. 

are going to use Gimp.  

You can also split the raster using Gvsig. You can take a look to our video tutorial ‘Formatting data, case 

study’ to see this alternative. Find the link to the video from the section ‘Documentation’ of the huellasolar 

the png file we have just saved. 

We are going to activate the grid so it helps us to draw our tiles. 

>’Preferences’ 

 

> tab ‘Default grid’. And type the values of Spacing Width and Height. We are g
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‘Selection’. In the explorer we give name to the file to be saved and select type of file .PNG 

 

will cover an area of 1200x1200m and it will have 4 tiles of 600x600m each one. 

You can also split the raster using Gvsig. You can take a look to our video tutorial ‘Formatting data, case 

study’ to see this alternative. Find the link to the video from the section ‘Documentation’ of the huellasolar 

> tab ‘Default grid’. And type the values of Spacing Width and Height. We are going to use 
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The grid must be displayed. Select the menu ‘View’ and check in ‘Show grid’. 

 

 
 

Now our image has the grid overlayed: 

 



 

 

We are ready to draw the tiles of our map

Click on the guides and drag inside the image. Place the division lines marking the tiles of your map. 

 

 

Use the grid to draw the tiles of your map. All the 

600x600px. 

 

The tiles of your map do not have to size 600x600px. You can choose other dimension but huellasolar does 

not admit tiles of more than 600px.

 

Click on the guide and drag to 

place a division line 

The position of the line is 

displayed here while you are 

dragging it. 

We are ready to draw the tiles of our map. 

the image. Place the division lines marking the tiles of your map. 

Use the grid to draw the tiles of your map. All the tiles must have the same dimension. In our case 

The tiles of your map do not have to size 600x600px. You can choose other dimension but huellasolar does 

not admit tiles of more than 600px. 

The position of the line is 

displayed here while you are 
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the image. Place the division lines marking the tiles of your map.  

 

tiles must have the same dimension. In our case 

The tiles of your map do not have to size 600x600px. You can choose other dimension but huellasolar does 



 

You can zoom to place the lines exactly in their pos

 

The result is something like this: 

 

 

We have marked our four tiles of 600x600px. In the screenshot 

0101,0102,0201,0202. 

 

 

The tiles of the map must be saved with names with four numbers 

correspond to the column and the last two digits are for the row. The tile 0101 is placed in the first column 

first row. It starts from the lower left corner. Null values such as 0000 are not admitted for the huellasolar 

system. 

 

Once we have drawn our tiles we are going to save each one as a png file. We will use the tool Guillotine 

placed at ‘Image’->’Transform’->’Guillotine’

 

You can zoom to place the lines exactly in their position. 

four tiles of 600x600px. In the screenshot we have numbered them as 

The tiles of the map must be saved with names with four numbers each one. The first two digits 

correspond to the column and the last two digits are for the row. The tile 0101 is placed in the first column 

first row. It starts from the lower left corner. Null values such as 0000 are not admitted for the huellasolar 

tiles we are going to save each one as a png file. We will use the tool Guillotine 

>’Guillotine’ 

0101 

0102 

0201 

0202 
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we have numbered them as 

each one. The first two digits 

correspond to the column and the last two digits are for the row. The tile 0101 is placed in the first column 

first row. It starts from the lower left corner. Null values such as 0000 are not admitted for the huellasolar 

tiles we are going to save each one as a png file. We will use the tool Guillotine 



 

 

This will create a different image for each rectangle delimited by the lines of division.

Save the fragments corresponding to your tiles as png files with their names (0101.png

Now we use the option ‘File’->’Export As’ to save the files.

 

 

Once you have saved the png files we recommend to check that the size in pixels of all the

On the contrary you should adjust your lines of division.

 

We have our tiles ready to be processed by huellasolar

This png files must be uploaded to the server as it is explained in the section 9 of this guide.

 

  

for each rectangle delimited by the lines of division.

Save the fragments corresponding to your tiles as png files with their names (0101.png

>’Export As’ to save the files. 

Once you have saved the png files we recommend to check that the size in pixels of all the

On the contrary you should adjust your lines of division. 

We have our tiles ready to be processed by huellasolar. 

This png files must be uploaded to the server as it is explained in the section 9 of this guide.
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for each rectangle delimited by the lines of division. 

Save the fragments corresponding to your tiles as png files with their names (0101.png, 0102.png etc) 

Once you have saved the png files we recommend to check that the size in pixels of all the files is the same. 

This png files must be uploaded to the server as it is explained in the section 9 of this guide. 
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11. Appendix II. Differences between results with PNG ot TIF files 

 

 

Tif files deal with decimal values but png files only support integer values.  

For example, a pixel which in a tif file has the value of 34.2, in a png file will be 34. 

Therefore, results from tif files will have softer transitions than results from png files as it is shown in the 

following images. 

 

Results from TIF 

 

Results from PNG 

 
 

As it can be seen, especially in inclined planes as in the roads in the center, results from png file are split up 

in horizontal sections while results from tif file have more gradual transitions. 
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12. Appendix III. Trimming  a Geotif with a Kml file 

 

 

Now multiple users can build a radiation map using huellasolar. 

When a user decides to take part in a map in huellasolar, a number of kml files are sent to his inbox. These 

kml files contain the bounds of the tiles of the map. 

This appendix explains how to trim geotif files using kml files and, therefore have the data split in files 

corresponding to the tiles of the map.  

 

12.1. Setting up the coordinate reference system in Qgis 

 

First of all we are going to open a new project using Qgis and set up the coordinate reference system that 

correspond to the source of data. 

 

In the following example we are working with Lidar from the city of Vitoria-Gasteiz. These files are in 

projection EPSG:25830. 

On the other hand, the KML sent by huellasolar are in EPSG:4326 (WGS 84) 

 

Open a new project in Qgis: 

 

 
 

1. Select the button on the bottom right where the current projection is displayed 

2. Activate the option ‘Enable on the fly CRS trasformation’ 

3. Type the reference for your data. In our case EPSG:25830 

4. Select the item from the list below 

5. Apply and Ok 
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12.2. Merging the geotif 

 

Is the work area is covered by several geotif we must merge them. 

Go to the Menu Raster->Miscellaneous->Merge 

 

 
 

1. Select the tif files to merge. This field allows multiple selection 

2. Enter the name for the merged file 

3. Select the optio to load file into canvas when finished. 

 

The layer with the merged file is now added to the project. We must check if the layer is in the correct 

coordinates system. 

Select the layer from the layers panel. Right click and select ‘Properties’ in the pop-up window. 
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Check that the coordinate reference system of the layer is the correct one. In our case EPSG:25830. If it is 

not the case change it. 

 

 
Make zoom to layer to center the view 

 

12.3. Adding the KML files 

 

Go to the Menu Layer->Add Layer->Add Vector Layer and select the kml files 

If everything goes well we can see something like the image below 
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In the capture we have applied transparency to the kml layers to see the geotiff below. If you do not see 

the kml files overlapping the map check if the projection of the kml layers is (EPSG:4326 WGS 84). 

 

If we are working in a shared project in huellasolar now it is recommendable to check if the position of the 

kml files is exactly the same location in the map in the web. To this purpose we can visit the edition panel 

of the shared map in huellasolar and make a visual verification. 

 

For example, the image below is taken from the edition panel of the map in huellasolar. 

 

 
 

As you can see the tiles are located exactly in the same position in both images. 

 

12.4. Trimming the tiles 

 

We are going to use the tool ‘Clipper’ from the Menu Raster->Extraction->Clipper 

However, before we must save again the raster using the tool Raster->Projections->Wrap (Reproject). 

Why do we do this step? Otherwise when we use ‘Clipper’ an error is prompted ‘Cannot compute bounding 

box of cutline’. With layer saved using Wrap this problem is solved. 

 

Raster->Projections->Wrap (Reproject) 

 

1 

2 

3 



 www.huellasolar.com 

 

 

1. Input file the geotif merged in point 12.2 

2. Type the name for the output file 

3. Source and Target SRS are the same and correspond to the SRS of the data (EPSG.25830 in our 

example) 

 

Now we can ‘Clip’ the layer. Raster->Extraction->Clipper 

 

 
 

1. Input raster. The one we have just saved using Wrap 

2. Type the output name i.e. 5252_cut.tif 

3. Check the option ‘Mask Layer’ 

4. Select the mask layer corresponding to the sector to clip 

 

Ok to save the geotif. 

 

Now we must check the dimension in pixels of the file. 

If you have followed the method in this manual, when we transformed the lidar file in a tif file, we applied a 

ratio step-size/pixel-size = 2 (Point 5 in this guide). 

This means that the file we have just saved sizes 1/2 of its real dimension. 

For example, if the original lidar was for an area of 600x600m, the file we have saved is 300x300px. 

If you are working in a shared map of huellasolar, it is always divided into tiles of 600x600m and huellasolar 

always works with a ratio m/pixel = 1. Therefore our tif files for each tile must size 600x600px. 

 

Therefore we are going to ‘save as’ our tif in a new file of exactly 600x600px. 

Put the mouse over the name of the layer in the Layers Panel, in our example layer ‘5252’, and right click. 

Select ‘Save as’ in the pop-up window. 
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1. Name the output file. We recommend do not to overwrite the original file to avoid errors while 

saving. In the image we are naming the new file as ‘5252_resized.tif’. 

However when you process the file with the desktop tool of huellasolar it must be named again as 

‘5252.tif’ (following with the example) otherwise the file will be discarded. 

2. Resolution Horizontal and Vertical must be 1. Check that the values of columns and rows are 

exactly 600x600 (in this example we are working with tiles of 600x600m). 

Notice that it is probably that you need to add some decimal corrections. In the image we have use 

coefficients 1.004 and 1.001 instead of 1. This is caused because of decimal variation when we 

change from coordinates systems. 

 

Ok and the tif file will be saved with the correct dimensions. 

 

Now you can proceed to generate the data for the tile. You can continue in the point 7 of this manual 

‘Building data packages with huellasolar’ 

 

Remember that, when you are generating the data for a tile it is strongly recommended that you had also 

the tif files for the adjacent tiles, and that all these files were located in the work directory. This way there 

is no lost of reliability in the edges of the tile. 
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